[bookmark: _Toc474411981][bookmark: _Toc474662741]Welcome!
[bookmark: _Toc474411982][bookmark: _Toc474662742]Move into your new Office
[bookmark: _GoBack]With Office 2007, not since we moved from command codes to icons in the early 1990’s was I as excited about a version of Office and neither was there a more magnificent change to the Office system. With each version of Office (2010/2013 and now 2016), there are new features and greater productivity. We’ll explore some of the latest and greatest features of Office 2016 and review some of the “greatest hits” of Microsoft Office since Office 2010.
Since you are a current Microsoft Office user, you will, like me, need some time adjusting to where items were in previous versions of Office and where items are in the new version of Office, especially if you are moving directly from Office 2003/2007 to 2016 and bypassing Office 2010 and 2016.  Don’t worry if you experience lapses in productivity in finding items and knowing if Microsoft has removed or simply moved the item to a new location that it the purpose of this book and course to help you know the differences and quickly get up to speed in using the new interface and popular features.
Your new Office is ready, let’s move in.
[bookmark: _Toc474411983][bookmark: _Toc474662743]About this Course. . . 
I designed this course and book only for current Microsoft Office users regardless of the previous version of Office.  This book is not designed for people who are completely new to Office – I have other books and courses for new users.  We will compare the differences in previous versions with the new version so you’ll know where your important commands are located in the new Office. We’ll look at the similarities with the Office 2007/2010 and previous versions, too, such as the good, old Keyboard Shortcuts. 
We will examine Word, Excel, PowerPoint, and Outlook and the common features in all of the Office Suite and then we will look at specific changes to Word, Excel, PowerPoint, and Outlook. This book will not be exhaustive in your quest for knowledge and being a power user but does give you a quick start and reference for using the new interface, command buttons, and making you more productive quicker.  This book will help you determine where you may need to continue your education, such as in Excel.  However, this book may be all you need for your transition to the new Office.
Enjoy your course and your new knowledge in Office 2016.
Now, let’s see how sweet Office 2016 is.
Write your notes here: ________________________________________
_____________________________________________________________
_____________________________________________________________.



[bookmark: _Toc474411984][bookmark: _Toc474662744]The New Interface
One of the best new features of Office, since 2007, is the new user interface including the Quick Access Toolbar, Tabs, and Ribbon.  Microsoft calls this type of interface a results-oriented interface and I must agree – you truly will get to your desired results, effects, and functionality with less time and minimized frustrations – for the most part.  The number of dialogue boxes has decreased and Task Panes are still around to assist you.  The good old toolbars, such as Standard and Formatting, that us old-timers have used since the early 1990’s are gone, except for one – the new Quick Access toolbar.  Without a doubt using the new Office Suite will increase your productivity and make getting to functions much easier and with fewer clicks and less frustration.  The Home Tab in Word 2016 displays here with the Quick Access Toolbar below the Ribbon and above the Ruler and the Home Tab’s Groups and Command Buttons displayed. Command Buttons
Groups
Tabs

[image: ]Besides the increase functionality using the tabs and ribbon, there is new power in using the shortcut menus with “right clicking” or using the secondary mouse button.   When you “right click” or use your secondary mouse button you still receive the Shortcut menu including some of your favorite commands, such as copy and paste.  Also you receive a Mini Toolbar containing favorite commands to use such as font, bold, the format painter and other often used commands.  This is another time saving feature for applying formatting to selected areas of your document, spreadsheet, presentation and other Office files.
[image: ]There is the scrolling Zoom, replacing the Zoom box, in the status bar of all applications that changes your view as you scroll through your percentages.  A picture of the new scrolling zoom is at right and allows you to see your changes in “real time” rather than guessing the percentage you need.  
Office offers a preview of your formatting, too, such as when you select your text and scroll through the fonts or font size the application will show you the effect changes before you make your final click or selection.  This feature is called Live Preview and saves a lot of time.
We will examine these user interface features and new ways to getting to old functionality, such as how the tabs and ribbons work in using popular formatting options for your documents, spreadsheets, and emails.  We will look at common features across the new Office 2016, such as the improvements and enhancements to the File (Backstage View) Tab, Customizing the Ribbon, and the Quick Access toolbar. Then we will examine some of the new functionality in Word, Excel, PowerPoint, and Outlook using the new interface.  
Welcome to your new office, now let’s get familiar with our new surroundings, and interface.




[bookmark: _Toc474411985][bookmark: _Toc474662745]Quick! Access the Toolbar
[bookmark: _Toc474411986][bookmark: _Toc474662746]The Quick Access Toolbar in Word
For years, we have used many toolbars in the Office Suite, gone are all of the toolbars, they are replaced with the tabs and pop-up dialogues boxes and task panes.  We still have one toolbar available for us to put our favorite commands.  The Quick Access Toolbar appears at the top your screen and pictured here.
[image: ]This has the Save, the (Very Popular) Undo, and Repeat command buttons and other buttons depending on the application you use.  You can customize the Quick Access Toolbar easily.  We’ll add some of my often used icons and actions to the toolbar – I encourage you to play around and add your own favorite icons. 
Why use the Quick Access Toolbar? While using the Ribbon, Groups, and Commands are productive, you must remember where the commands reside in the Ribbon and you must navigate to that command to use it. I prefer to have my favorite commands on my Quick Access Toolbar, so I don’t have to remember where the command is in the Ribbon and I don’t have to navigate the Ribbon to use the command. The Quick Access Toolbar stays on your screen and is easy to tailor to your needs. 
Here’s how to customize the Quick Access Toolbar using Customize Quick Access Toolbar:
Click on the Drop Down arrow at the end of the toolbar and in the cascading menu choose some of your often used items, such as Quick Print and Print Preview and Print. Clicking these items adds them to your Quick Access Toolbar.  
Unfortunately, you must keep opening the menu to add the buttons; the cascading menu doesn’t remain open as you click all of your buttons.  I have added all of my buttons to the Quick Access toolbar.

Now, we will use the More Commands item in the Quick Access Toolbar. You want to use the More Commands and Customize panes for two reasons:
You can add more than one button at a time and you may add buttons not in the ribbon,
You can re-order the buttons to suit your needs.

To add other favorite command buttons, click the More Commands … item on the Customize Quick Access Toolbar menu.
The Word Options Quick Access Toolbar Customize screen appears pictured at right.  
First, I reorder my commands buttons to match how I had them for over 19 years using the Standard toolbar, so I move New to first place, Save and Save As are next, followed by Open, and then Undo, my favorite button.  You will want to move your buttons to suit your needs and productivity in locating a popular command quickly and easily no matter what tab you may use in the Ribbon.
If you want to move the command, select it and click the up or down arrows at the right of the buttons for your toolbar.  This will move your selected command up or down on your toolbar. 
Next  Select Copy from the Popular Commands pane and add it to your Quick Access Toolbar – Notice that wherever your cursor or selector was located in the Customize Quick Access Toolbar pane Office adds the button beneath your cursor/selection.  
You may add your favorite buttons by double clicking the item, such as Font or Font Color, or selecting an item and clicking the Add button.  Your buttons add below where your cursor/selection is in the Customize Quick Access Toolbar pane.
Notice at the top of the screen that we are making these changes to all of our documents (For all documents (default)).  You can create and modify your Quick Access Toolbar for different documents and needs.
Now, let’s use All Commands and add some of my favorite buttons.
Change Choose command from box using the drop down list to All Commands.
[image: ]Wow! There are a lot of commands in the Office Suite.  We won’t add all of these. 
[image: ]With an item selected in your All Commands pane, press the letter R on your keyboard – the Pane jumps to the letter R in the command list.  If you keep your letter pressed on your keyboard, Office will scroll through the commands that begin with that letter. Or you may use the scrolling bar or keyboard arrows to move through your commands. We want to add Reveal Formatting to our Quick Access Toolbar.  Reveal Formatting isn’t in the Ribbon and is a cool button to use in order to know all about your formatting and to compare different areas of the document’s formatting differences. 
I add my favorite things in Word using the All Commands pane, such as:
Grow Font by 1 Pt,
Shrink Font by 1 Pt,
Change Case, 
[image: ]Change Shape, 
Insert Picture,
Speak. 
Continue to add some of your favorite commands to the toolbar.
Don’t forget to reorder them using the arrow buttons.
Once complete, click the OK button at the bottom of your screen.
Also, I like having my Quick Access Toolbar below the ribbon.  You may place the Quick Access Toolbar below or above the Ribbon using the shortcut menu for the Customize Quick Access Toolbar that we have used previously. At the bottom of the pane, you may choose to Show Above/Below the Ribbon.  I am changing mine to Show Below the Ribbon as displayed here. 

[image: ]  A Hot Tip! Adding buttons from a terrific shortcut menu! We can add any button on the Ribbon to our Quick Access Toolbar by right-clicking the button; in this case, I have my Format Painter button selected and right click on it to receive the shortcut menu that displays Add to Quick Access Toolbar.  Note – If the Add to Quick Access Toolbar is grayed out – then you already added the button! Let’s try it out. 
With the Home Tab’s buttons visible Right-click on one of your favorite icons – I’ll right click the Show/Hide button. 
From the menu choose Add to Quick Access Toolbar.
The icon displays on your toolbar at the end. 
You can add and remove buttons with ease to and from your Quick Access Toolbar, using the shortcut menu.  But you cannot rearrange them unless you use the Customize Quick Access Toolbar pane in the Options menu.
The shortcut menu on the Ribbon and Quick Access Buttons provide other options, too, such as Customizing and Collapse the Ribbon that we will learn next.
As you use your new Office, you’ll discover buttons that you will want available all of the time.  Unlike the previous versions of Office your Home, Insert, Page Layout and other tabs change your command buttons; therefore, to have a popular command constantly available without clicking a tab or right clicking, you’ll have to add it to your Quick Access Toolbar.   You may assign your command to a keyboard shortcut or use one already defined for you such as the ever popular CTRL + C for copy.  
[image: ]If you mess up your toolbar and want to put it back to the way the toolbar came from the Microsoft Factory or its original sate, in the Customization screen you can click the Reset button and Office provides this message.  If you click the Yes button, all of your customization disappears for you to start fresh adding your icons. 
Now, let’s accomplish the following:
In Excel, Outlook, and PowerPoint – we’ll add some of our favorite buttons to these applications and the Quick Access Toolbar.



[bookmark: _Toc474411987][bookmark: _Toc474662747]
The Quick Access [image: ]Toolbar in Excel
With Excel open at a blank workbook, Click the Quick Access Toolbar’s Option arrow and add the buttons from the shortcut menu as displayed here. 
After adding the buttons from the shortcut menu, Click the arrow again and at the Customize Quick Access Toolbar click the More Commands… option.

As we accomplished in Word, add your favorite Excel buttons using the Popular Commands item in the Choose commands from: box.  Here are some of my favorite commands to add to and rearrange on my Quick Access Toolbar using the Popular commands item:
Custom Sort,
Insert Sheet Rows,
Insert Sheet Columns,
[image: ]Set Print Area,
Freeze Panes,
Page Setup,
Paste Special,
PivotTable.
Add your popular commands and rearrange them on the Quick Access toolbar by selecting a command and using the Up and Down arrows to move your buttons.


Next change your Choose commands from box to All Commands as circled above.  Press the letter A and scroll to AutoFilter.  Add AutoFilter to your Quick Access Toolbar this command button doesn’t appear on the Ribbon and is very helpful.  This one button accomplished two tasks – first it will filter for whatever you have selected and it will turn on your filtering for you.  I also add the Clear Filter button. 

 Hot Tip! Speak to me baby! I add the Speak Cells button to Excel and the Speak button to Word and Outlook. The Speak button will have my computer read my selected text, paragraphs, emails, and Excel cells. After selecting your text in Word/Outlook or cells in Excel, click the speak button and your computer reads your selection. This is a great proofreader for you. You may press the button again or press the ESC button your keyboard to top the speaking. Speak only reads your text selection and does not turn itself on, so you won’t be annoyed. 

Continuing adding your favorite buttons to your Quick Access Toolbar and when complete, Click OK.
Next, decide if you want to show the Quick Access Toolbar above or below the Ribbon. 
Now, you are ready to work with productivity in Excel. Let’s customize our Outlook’s Quick Access Toolbar, now.


[bookmark: _Toc474411988][bookmark: _Toc474662748]The Quick Access Toolbar in Outlook
Outlook has a couple of Quick Access Toolbars so is a bit more confusing. You will need to set your Quick Access Toolbar for your main view (such as Email, Calendar, Tasks) and then another Quick Access Toolbar for your new items (such as New Email, New Appointment), so get ready to work with a coupld of new Quick Access Toolbars in Outlook
[image: ]With Outlook open, Click the Quick Access Toolbar’s Option arrow and add the buttons from the shortcut menu as displayed here. 
After adding the buttons from the shortcut menu, Click the arrow again and at the Customize Quick Access Toolbar click the More Commands… option.

As we accomplished in Word and Excel, add your favorite Outlook buttons using the Popular Commands item in the Choose commands from: box and then use the All Commands item in the Choose commands from box.  Here are some of my favorite commands to add to and rearrange on my Outlook Quick Access Toolbar:
Outlook Today,
Categories,
My Computer,
My Documents,
Speak,
Open In New Window,
Expand/Collapse.

Now, that we have customized our Quick Access Toolbar it is time for us to customize our Ribbon with our own Tab – A Terrific Feature from Office 2010.


[bookmark: _Toc474411989][bookmark: _Toc474662749]Productive Ribbon, but 
Where are the Bows?
The Home Tab appears above. The Ribbon has Tabs, Command Buttons (aka Icons), and Groups.  As you can see, the Ribbon is packed with Command buttons and are organized in a logical manner.  Command Buttons
Groups
Tabs


An Important Note  - Your screen resolutions will affect the number of commands you may see in a group.  The lower the resolution your computer is set the fewer commands you may see – the group will display an arrow for you to expand and view the commands.  The higher the resolution the more commands you may view in a group without the need to expand the group.  For example, with my screen resolution set at 800 x 600 my Editing Group required me to expand the group in order to view and use the commands.  With my screen resolution set at 1024 X 768 my editing group displays the Find, Replace, and Select Commands. You may change your resolution settings using the Display Properties and the Settings Tab in Window.

Microsoft’s Office Ribbon is productive and combines our previous toolbars, menus, and task pane features in a much easier and a more powerful way of working with the applications. 
With Office 2013 and 2016, we have a new Ribbon Display Options command on the Title Bar – next to Minimize, Restore, and Close buttons. 
Here’s a brief explanation of these Ribbon Display Options:
Auto-hide completely hides the Ribbon and reappears when you click/tap the top of your screen.
Show Tabs is a collapsed/minimized view of your tabs with the tabs displayed but not the Groups and Command buttons. You’ll need to click the appropriate tab to use a command.
Show Tabs and Commands is the default view showing you the Tabs, Groups, and Command buttons. 
NOTICE: The Quick Access Toolbar showing below the ribbon stays in view, except the Auto-hide view.
Two important and time saving Hot Tips for you in using the Ribbon and Tabs!
 Hot Tip 1:  Collapse the Ribbon! Four ways to minimize the Ribbon – First, the Ribbon takes up a lot of space on your screen. You may minimize or collapse the Ribbon and use it only when you click on a Tab. 
The Ribbon Display Options button on the Title Bar and selecting Show Tabs, as detailed above.
To collapse the Ribbon, double click the active Tab’s Name. Double clicking a tab expands/collapses the ribbon, too.
Right click on any tab or command button on the Ribbon and from the short cut menu choose Collapse the Ribbon at the bottom of the menu. 
Keyboard shortcut of CTRL + F1 – when you press your CTRL (Control) and the F1 keys simultaneously on your keyboard the Office application minimizes and expands your Ribbon, too. 
Why minimize The Ribbon?  The Ribbon takes a lot of space. With the Ribbon minimized you have more room in which to work on your file.  With the Ribbon minimized, to use a tab, you click the tab and the Ribbon’s tab expands for you to use the Command Buttons.  After clicking the button you want and you click back into the body of your document, worksheet, or presentation the Ribbon minimizes again. This is similar to using the old Menu bar.  The difference is the Menu bar was vertical and text oriented and the Ribbon is horizontal and more graphically oriented. 
 Hot Tip 2: Second, if you have a scroll wheel/button on your mouse and the Ribbon is NOT collapsed, you may scroll through the different tabs rather than clicking the tab.  Moving your cursor to the Ribbon and rolling your scrolling button/wheel up or down changes the tabs for you! You must first click on a tab for this to work; otherwise, the application will scroll through your file – not the Ribbon.  
 An Important Gotcha! With the Ribbon collapsed you cannot scroll through the Tabs as described above.  You’ll have to remove Collapse the Ribbon in order to scroll through your tabs and command items. 
Try these two shortcuts, I think you’ll like using these two features in Office.
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